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Module 1 – Creating a Windows Server 2008 Forest 

Requirements 

For this exercise you will need a Virtual Machine with at least one hard-drive.  This can be used for the whole 
course. 
 

Exercise 1: Install Windows Server 2008 
 

1. Insert the Windows Server 2008 installation DVD 

2. Power on the system  

3. Select the language, regional settings and keyboard layout that are correct for your system and Click 

Next 

4. Click Install Now  

5. Select the Windows Server 2008 Enterprise (Full Installation) and Click Next  

6. Select the I Accept The License Terms check box and click Next  

7. Click Custom 

8. Select Volume to install the Operating System  

9. Click Next  

10. Click OK  

11. Type an Administrator Password and Confirm it. (Pa$$w0rd) 

12. Click OK  

 

Exercise 2: Perform Post-Installation Configuration 
 

1. Wait for the desktop for the Administrator account to appear 

2. Use the Initial Configuration Tasks window to configure  

a. Time Zone (appropriate for your area) 

b. Computer name: DC1 (do not restart) 

3. Click the Configure Networking link in the Initial Configuration Tasks window  

4. Select Local Area Connection  

5. Change Settings of this connection Click on the Toolbar  

6. Select Internet Protocol version 4 and click Properties 

7. Click use the following IP address  

a. IP address: 10.10.0.10 

b. Subnet mask: 255.255.0.0 

c. Default gateway: 10.10.0.1 

d. Preferred DNS Server: 10.10.0.10 

8. Click OK and the close  

9. Select the Do Not Show This At Logon check box  

10. Click the Close Button on the Initial Configuration Tasks window  
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Exercise 3: Install a New Windows Server 2008 Forest using dcpromo 
 

1. Click Start, click Run, type dcpromo  

2. Click next  

3. Review the warning on the Operating Systems Compatibility page  

4. On the Choose a Deployment Configuration page, type Finalvision.com and Click Next  

5. On the Set Forest Functional Level Choose Windows Server 2008  

6. Click Next  

7. Click Yes, The Computer Will Use A Dynamically Assigned IP Address (Not recommended) 

8. Click Yes to close to close the Active Directory Domain Services Installation Wizard warning 

message  

9. On the location for SYSVOL, Database, Log Files page, accept the defaults and Click Next  

10. On the Directory Restore Mode Password page, type Pa$$w0rd in both spaces and Click Next  

11. On the Summary Page, review selections  

12. Click Next (Installation will continue and Finish 
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Module 2 – Install the Server Domain Controller 

Requirements 

Use the DC1 that was created in Exercise 1.  Also you will need another blank VM that can you will use to install the 
Core Server on. 
 

Exercise 1: Install Server Core 
 

1. Insert the Windows Server 2008 installation DVD 

2. Power System On  

3. Select the language, regional settings, and keyboard and click next  

4. Click Install Now  

5. Select Windows Server 2008 Enterprise (Server Core Installation) and Click Next  

6. Accept the EULA and Click Next  

7. Click Custom (Advanced)  

8. Select the Disk to install the Operating System and Click Next  

9. Logon to the system after installation is completed  

10. Change the password , Enter Pa$$word in each New Password and Confirm Password boxes and 

Press ENTER 

11. Click OK  

 

 

Exercise 1: Perform Post-Installation Configuration on Server Core 
 

1. Type netdom renamecomputer %computername% /newname:ServerCore and Press ENTER 

2. Confirm the operation press Y  

3. Type netsh interface ipv4 set address name=”Local Area Connection” source=static 

address=10.10.0.12 mask=255.255.0.0 gateway=10.10.0.1  1 and Press ENTER  

a. Sets the IP address for NIC  

4. Type netsh interface ipv4 set dns name=”Local Area Connection” source=static address=10.10.0.10 

primary Press ENTER  

a. Sets the Preferred DNS 

5. Type ipconfig /all and Press ENTER 

a. Confirm the IP configuration  

6. Type shutdown –r –t 0  

a. Restarts the server  

7. Log on as Administrator  

8. Type netdom join %computername% /domain: finalvision.com 

a. Joins the server to the finalvision.com domain  

9. Restart by typing shutdown –r –t 0  

10. Type oclist 

a. Lists the server roles that are installed 

11. Type ocsetup and Press ENTER  

12. Click OK  

13. Type ocsetup DNS-Server-Core-Role Press ENTER 

a. Must be followed directory , commands are case sensitive  

b. Installs the DNS Server role on the Core Server  

14. Type oclist 

a. Observer DNS Role is installed  
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Exercise 2: Create a Domain Controller with Server Core 
 

1. Type dcpromo /unattend /replicaOrNewDomain: replica /replicaDomainDNSName: finalvision.com 

/ConfirmGC: Yes /UserName:Finalvision\Administrator /Password: * 

/SafeModeAdminPassword:Pa$$w0rd Press Enter 

a. This will start the Domain Controller install 

2. When prompted to enter credentials , type Pa$$w0rd for the administrator account in FinalVision.com 

in the FinalVision.com domain and Click OK  

a. Domain Controller will be installed 

 

Exercise 3: Remove a Domain Controller 
 

1. Logon to the Server Core 

2. Type dcpromo  /unattend /AdministratorPassword:Pa$$w0rd 

a. This will remove the Domain Controller 
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Module 3 – Creating and Managing a Custom MMC 

Requirements 

Use the DC1 that was created in Module 1 - Exercise 1.   
 

Exercise 1: Create a Custom MMC 
 

1. Logon to the DC1 as Administrator (Pa$$w0rd) 

2. Click Start button and in Start Search box type MMC and Press ENTER 

3. Choose Add/Remove Snap-in from File Menu  

4. Select Active Directory Users and Computers and click Add  

a. Notice Active Directory Schema is not presented  

5. Click OK to close the Add/Remove Snap-in Dialog Box  

6. Click Start Button and type cmd 

7. At the command prompt type regsvr32 schmmgmt and press ENTER  

8. Click OK  

9. Return the MMC  

10. Add the Active Directory Schema Snap-In  

11. Add the Computer Management Snap-In and direct it to Local Computer 

12. Click on Finish  

13. Click on OK to close Add/Remove Snap-In 

14. Choose Save from the File and save menu and save the console to the desktop with the name 

Admin.msc 

15. Close the console  

 

Exercise 2: Add a Snap-in to a MMC 
 

1. Open the Admin.msc  

2. Choose Add/Remove Snap-in from the File Menu  

3. Add the Event Viewer and direct it to the Local Computer  

4. Click OK to close the Add/Remove Snap-In  

5. Save and close the console 
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Exercise 3: Manage the Snap-ins of an MMC  
 

1. Open the Admin.msc 

2. Choose Add/Remove Snap-ins from the File Menu  

3. Select Event Viewer from the list of Selected snap-ins  

4. Click Move Up button  

5. Select Active Directory Schema  

6. Click Remove Button  

7. Select Computer Management  

8. Click Edit Extensions  

9. Select Enable Only Selected Extensions  

10. Deselect Event Viewer 

11. Click OK to close the Extensions For Computer Management  

12. Click OK to close the Add/Remove Snap-ins Dialog box  

13. Save and Close the console  

 

Exercise 4: Prepare a Console for Distribution to Users  
 

1. Open Admin.msc 

2. Choose Options from the File Menu  

3. In the Console Mode drop-down list, choose User Mode-Full Access 

4. Click OK  

5. Save and close the console  

6. Open the console by double-clicking it  

7. Click the File menu  

a. There is not an Add/Remove Snap-ins option  

8. Close the console  

9. Right-Click the console and choose Author 

10. Click the File Menu  

a. Add/Remove Snap-ins option appears  

11. Close the Console 
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Module 4 – Creating and Locating Objects in Active Directory 

Requirements 

Use the DC1 that was created in Exercise 1.   
 

Exercise 1: Create Organizational Units 
  

1. Logon to DC1 as an Administrator 

2. Open the Active Directory User and Computers snap-in  

3. Expand the Domain node  

4. Right-Click the Domain Node and choose New and Select Organizational Unit  

5. Type the name of the Organizational Unit: Employee 

6. Select Protect Container from Accidental Deletion  

7. Click OK  

8. Right-Click the OU and Choose Properties  

9. In the Description Field, type Non-administrative user identities  

10. Click OK  

11. Create the following  

 

OU name OU Description 

Desktops Desktop Computers 

Groups Non-administrative groups 

Admins Administrative groups 

Server Server 

Laptops Laptop computers 

 

 

Exercise 2: Create Users 
 

1. Right-Click Employees OU and Select New User Input the following information remember to click 

Next to Continue   

 

First Name Last Name Logon Name Password Change Password 

Dan Holme dholme Pa$$w0rd Yes 

Robert Redford rredford Pa$$w0rd Yes 

Barbara Bush bbush Pa$$w0rd Yes 

Linda Mills lmills Pa$$w0rd Yes 

Jackie Roberts jroberts Pa$$w0rd Yes 
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Exercise 3: Create Computers 
 

1. Right-Click Servers OU FinalVision and Select New Computer  

2. Computer name box type SVR1 and Click OK  

3. Right-Click the computer and choose Properties  

4. Just look at properties do not change any  

5. Click OK  

6. Create the following 

 

Computer Name OU 

EX1 Server  

SharePoint01 Server 

Desktop01 Desktops 

Desktop02 Desktops 

Laptop01 Laptops 

Laptop02 Laptops 

 

Exercise 4: Create Groups 
 

1. Right-Click the Groups OU and Select New Group  

2. Type Finance for the Group Name  

3. Do not change the name of the Group Name (Pre-Windows)  

4. Select Security for Group Type  

5. Select Global for the Group Scope  

6. Click OK  

7. Right-Click Finance Group and select Properties 

8. Examine the Properties but do not change them  

9. Click OK  

10. Create the following groups in Groups OU 

 

Group name Group Type Group Scope 

GG_Finance_Managers Security Global 

GG_Sales Security Global 

APP_Office 2007 Security Global 

 

11. Create the following groups in Admins OU 

 

Group name Group Type Group Scope 

GG_Help Desk Security Global 

GG_Windows Administrators Security Global 
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Exercise 5: Add Users and Computers to Groups 
  

1. Right-Click GG_Help Desk and Select Properties  

2. Click the Members Tab 

3. Click Add Button  

4. Select dialog box, type Robert  

5. Click Check Names  

6. Select Robert Redford 

7. Click OK to close the Select dialog box  

8. Click OK again to close the group properties  

9. Open the properties of the APP_Office 2007  

10. Click the Members Tab  

11. Click Add  

12. Select Desktop01 

13. Click Check Names  

14. Click Cancel  

a. Name Not Found Box 

15. In the Select box, Click Object Types  

16. Select Computers as an object Click OK  

17. Click Check Names  

a. Name will resolve  

18. Click OK  

 

Exercise 6: Find Objects in Active Directory 
  

1. Right-Click the Domain FinalVision click Find Objects  

2. In the Name Box, type Barb 

3. Click Find Now  

4. Right-Click Saved Queries Node  

5. Choose New and choose Query  

6. Type All Users in the Name Box  

7. Description box type User for the entire domain  

8. Click Define Query  

9. On the Users tab, in the Name box, choose Has A Value  

10. Click OK twice to close the dialog boxes  

11. Choose View and the click Add/Remove Columns  

12. In the Available columns list, Select Last Name and click the Add Button  

13. In the Displayed columns list, Select Type and click the Remove button 

14. Click OK  

15. Drag the Last Name Colum heading so that it is between Name and Description  

16. Click the Last Name column heading to sort it alphabetically by last name 
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Module 5 – Delegating Administrative Tasks 

Requirements 

Use the DC1 that was created in Exercise 1.   
 

Exercise 1: Delegate Administrative Tasks 
  

1. Logon to DC1 with Administrative Permissions  

2. Right-Click Employees OU and choose Delegate Control to launch the Delegation of Control Wizard  

3. Click Next  

4. On the Users Or Groups page, click the Add button 

5. Using the Select dialog, type Help Desl and then click OK  

6. Click Next  

7. On the Tasks To Delegate page, select Reset User Passwords And Force Password Change At Next 

Logon task 

8. Click Next  

9. Review the summary of the actions that have been performed and click Finish 

 

Exercise 2: View Delegated Permissions  
  

1. Right-Click the Employees OU and Choose Properties  

2. Click OK to close the Properties dialog box  

3. Click the View menu and Select Advanced Features  

4. Right-Click the Employees OU and choose Properties  

5. Click the Security tab  

6. Click the Advanced button  

7. In the Permission Entries list, select the first permission assigned to the Help Desk 

8. Click the Edit Button  

9. In the Permission Entry dialog box, locate the permission that is assigned, and then click OK  

10. Repeat steps 7-9 for the second permission entry assigned to the Help Desk  

11. Repeat steps 2 – 10 to view the ACL of a user in the Employees OU and to examine the inherited 

permissions assigned to the Help Desk 

12. Open the command prompt type dsacls “ou=employees,dc=contoso,dc=com” and press Enter 

13. Locate the permission assigned to the Help Desk 
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Module 6– Automating The Creation of User Accounts 

Requirements 

Use the DC1 that was created in Exercise 1 
First Level Employees, Groups 
A global security group in the Groups OU named Sales   
 

Exercise 1: Create Users with a User Account Template 
  

1. Log on to DC1 as Administrator  

2. Open ADUC and expand the domain  

3. Right-Click Employees OU and choose New and select User  

4. First Name Box type _Sales  

5. Last Name Box type Template 

6. User Logon Name type _salestemplate click Next  

7. Type Pa$$w0rd in the Password box and Confirm Password box 

8. Select Account Is Disabled check box , Click Next  

9. Click Finish 

10. Bring up Properties of the _salestemplate account  

11. Click Organization Tab 

12. In the Department box , type Sales  

13. In the Company box, type Final Vision, Inc. 

14. Click the MemberOf tab  

15. Click Add Button  

16. Type Sales and click OK  

17. Click Profile Tab 

18. Profile Path box, type \\DC1\profiles\%username% 

19. Click OK  

 

Exercise 2: Create a User with the Dsadd Command 
  

1. Open a command prompt 

2. Type dsadd user “cn=Mike Tyson,ou=Employees,dc=finalvision,dc=com” –samid Mike.Tyson –pwd 

* -mustchpwd yes –hmdir \\DC1\users\%username%\documents -hmdir U: 

3. You will be prompted to enter a password a password for the user twice.  Type Pa$$w0rd 

4. Open ADUC and confirm Mike’s account is configured as entered  

 

  

file://DC1/profiles/%25username%25
file://DC1/users/%25username%25/documents
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Exercise 3: Import Users with CSVDE 
  

1. Open Notepad and create the following file , Enter the following lines 

 

  

 

 

 

 

2. Save the file to your Documents folder as Newusers.csv 

3. Open a command prompt  

4. Type cd %userprofile%\Documents and press ENTER 

5. Csvde –I –f  Newusers.csv –k  

a. –k continues when an error occurs 

6. Open ADUC snapin and confirm that users were created  

7. Examine accounts to ensure all information was created  

 

Exercise 4: Import Users with LDIFDE 
  

1. Open Notepad and create the following file , Enter the following lines 

 

DN: CN=April Vow, OU=Employees, DC=FinalVision,DC=Com  

changeType: add  

CN: April Vow 

objectClass: user  

sAMAccountName: april.vow 

userPrincipalName: april.vow@finalvision.com 

givenName: April 

sn: Vow 

displayName: Vow, April 

mail: april.vow@finalvision.com  

description: Sales Representative in USA 

title: Sales Representative 

department: Sales  

company: Final Vision, Inc. 

 

DN: CN=April Vow, OU=Employees, DC=FinalVision,DC=Com  

changeType: add  

CN: Tony Gupta 

objectClass: user  

sAMAccountName: Tony.Gupta 

userPrincipalName: tony.gupta@finalvision.com 

givenName: Tony 

sn: Gupta 

displayName: Gupta, Tony 

mail: Tony.Gupta@finalvision.com  

description: Sales Representative in India 

title: Sales Representative 

department: Sales  

company: Final Vision, Inc. 

 

 

 

DN,objectClass, sAMAccountName,sn,givenName,userPrincipalName 

“cn=Lisa Turro,OU=Employees,DC=FinalVision,DC=Com”,user,lisa.turro,Lisa,Turro,lisa.turro@finalvision.com 

“cn=Steve Austin,OU=Employees,DC=FinalVision,DC=Com”,user,steve.austin,Steve,Austin,steve.austin@finalvision.com 

 

mailto:april.vow@finalvision.com
mailto:april.vow@finalvision.com
mailto:tony.gupta@finalvision.com
mailto:Tony.Gupta@finalvision.com
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2. Save the file to your Documents folder as Newusers.ldf 

3. Open a command prompt 

4. Type cd %userprofile%\Documents and Press ENTER 

5. Type ldifde –I –f newusers.ldf –k and Press ENTER  

6. Open ADUC and verify accounts have been created  

7. Confirm the user properties are populated 
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Module 7– Creating Users with Windows PowerShell and VBScript 

Requirements 

Use the DC1 that was created in Exercise 1 
First Level Employees, Groups 
A global security group in the Groups OU named Sales   
 

Exercise 1: Install Windows PowerShell 
  

1. Logon to DC1 as Administrator 

2. Click the Features node of the Server Manager  

3. Click Add Features link  

4. Select Windows PowerShell from the Features list, Click Next  

5. Click Install 

6. When the installation is complete, click Close  

7. Right-Click Windows PowerShell in the Windows PowerShell program group and Pin it the Start 

Menu  

 

Exercise 2: Create a User with Windows PowerShell 
  

1. Open Windows PowerShell 

2. Type $objOU=[ADSI]”LDAP://OU=Employees,DC=FinalVision,DC=Com” 

a. Connect to the Employees OU  

3. Type $objUser=$objOU.Create(“user”,”CN=Mary Star”) 

a. Create Mary Star object 

4. Type $objUser.Put(“sAMAccountName”,”mary.star”) 

a. Populates the Pre-Windows 2000  

5. Type $objUser.SetInfo() 

a. Writes account into Active Directory 

6. Type $objUser.distinguishedName 

7. Type $objuser | get-member 

a. Lists the populated attributes  
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Exercise 3: Create a New User with a Windows PowerShell Script 
  

1. Log on to DC1 as Administrator  

2. Open Notepad  

3. Type the following  

 

 

 

 

 

 

 

4. Save the script to your Documents folder as “Newuser.ps1”, with quotes to save as a non-text 

document 

5. Open Windows PowerShell  

6. Type cd documents and press ENTER  

7. Type set-executionpolicy remotesigned 

a. This will enable script execution  

8. Type .\newuser.ps1 and press ENTER 

9. Confirm that the user was created in Active Directory 

 

Exercise 4: Create a New User with a VBScript Script 
  

1. Open Notepad 

2. Type the following 

 

 

 

 

 

 

 

 

3. Save the script in your Documents folder as “Newuser.vbs”, including the quotes so that it is a non-

text document  

4. Open the command prompt  

5. Type cd %userprofile%\documents and press ENTER  

6. Type cscript.exe newuser.vbs  

7. Confirm that the user was created successfully in Active Directory 

 

 

 

  

$objOU = *ADSI+”LDAP://OU=Employees,DC=FinalVision,DC=Com” 

$objUser = objUser.Create(“user”,”CN=Scott Milner”) 

$objUser.Put(“sAMAccountName”,”scott.milner”) 

$objUser.Setinfo() 

 

 

 

Set objOU = GetObject(LDAP://OU=Employees,DC=FinalVision,DC=Com) 

Set objUser = objUser.Create(“user”,”CN=Toya Jackson”) 

objUser.Put(“sAMAccountName”,”toya.jackson”) 

objUser.Setinfo() 
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Module 8– Supporting User Objects and Accounts 

Requirements 

Use the DC1 that was created in Exercise 1 
First Level Employees, Groups 
A global security group in the Groups OU named Sales  
Scott Milner  
Toya Jackson 
Mary Star  
 

Exercise 1: View All Attributes of a User  
  

1. Logon to DC1 as an Administrator 

2. Open ADUC  

3. Open Employees OU and Right-Click Scott Milner  

4. Choose Properties  

5. Examine the tabs of the Properties dialog box  

6. Click the Telephone tab and enter information into the Notes field. Click OK  

7. Click View menu and select Advanced Features  

8. Open the Properties of Scott Milner and Click the Attribute Editor tab 

9. Scroll to locate the info attribute  

10. Locate the division attribute, double click it, type Subsidiary and click OK  

11. Locate the employeeID attribute, type 12345678 and then click OK  

12. Examine the other attributes  

13. Click OK to close the Properties dialog box 

 

Exercise 2: Manage Attributes of Multiple Objects 
  

1. In the Employees OU , select Scott Milner  

2. Hold the CTRL key and select Mary Star and Toya Jackson 

3. Right-Click any of the selected users and choose Properties  

4. On the General Tab, Select the Office box and type Miami 

5. Click the Account Tab 

6. Click on the Logon Hours button 

7. Click Sunday and click the Logon Denied option  

8. Click Saturday and click the Logon Denied  option then click OK  

9. Select the Computer Restrictions button and click the Log On to button  

10. Select the following option  

11. In the Computer Name box type DESKTOP01 and click Add  

12. Repeat the process for DESKTOP02 and DESKTOP03 then click OK  

13. On the Address tab, select the Street, City, State/Province and Zip/Postal Code boxes and Enter 

fictitious information 

14. Click the Profile tab and configure the \\DC1\%username%\documents home folder  

15. Click the Organizational tab and configure the company name, Final Vision, Inc. 

16. Click OK  

17. Open the user objects to confirm that the changes were applied 
  

file://DC1/%25username%25/documents
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Exercise 3: Manage User Attributes with DS Commands  
  

1. Open Windows PowerShell  

2. Type dsquery user –name “* Milner” | dsmod user –office “Sydney” –disabled “Yes” 

a. Modifies the location and account is disabled  

3. Confirm the changes in ADUC 

4. Type dsquery user –name “* Milner” | dsget user –samid –upn 

a. This will return the Pre-Windows 2000 account and the UPN of  Scott Milner 

5. Type the following lines in Windows PowerShell  

 

 

 

 

 

 

 

 

6. Confirm changes in ADUC 

 

  

$objOU = *ADSI+”LDAP://CN=Scott Milner,OU=Employees,DC=FinalVision,DC=Com” 

$objUser.psbase.InvokeSet(‘AccountDisabled’,$false) 

$objUser.Setinfo() 
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Module 9– Creating and Managing Groups 

Requirements 

Use the DC1 that was created in Exercise 1 
First Level Employees, Groups 
A global security group in the Groups OU named Sales  
Scott Milner  
Toya Jackson 
Mary Star  
 

Exercise 1: Create Groups 
  

1. Logon to DC1 as an Administrator 

2. Open ADUC and Select the Groups OU  

3. Right-Click Groups OU, choose New and then Select Group 

4. In the Group Name type Sales  

5. Select the Global group scope and Security group type Click OK  

6. Right-Click the Sales group and choose Properties  

7. Click the Members tab  

8. Click the Add button  

9. Type: Linda,Toya and click OK  

10. Click OK to close the Properties box 

11. Create two global groups Marketing and Consultants 

12. Create a Domain Local group named ACL_Sales_Folder_Read 

13. Open the properties of the ACL_Sales_Folder_Read group  

14. Add Sales, Marketing and Consultants to the ACL_Sales_Folder_Read group 

15. Add Linda  

16. Open the properties for the Marketing group  

17. Add the ACL_Sales_Folder_Read group  

18. Create a Sales folder on the C:\ 

19. Bring up the Advanced Security properties for the Sales  

20. Click Edit and click Add 

21. Click Advanced , and then click Find Now  

a. Notice groups with ACL_ prefix to assist in finding the groups faster 

22. Create a new groups called Christmas List and make it a Distribution Group 

 

Exercise 2: Convert Group Type and Scope  
  

1. Right-Click the Christmas List and choose Properties  

2. Change the group type to Distribution  

3. Click Apply  

4. Change the group scope to Universal click Apply  

5. Change the group scope to Global click Apply  

6. Click OK to close the Properties dialog box  
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Module 10– Automating the Creation and Management of Groups 

Requirements 

Use the DC1 that was created in Exercise 1 
First Level Employees, Groups 
A global security group in the Groups OU named Sales  
Scott Milner  
Toya Jackson 
Mary Star  
 

Exercise 1: Create a Group with Dsadd 
  

1. Logon to DC1 as an Administrator 

2. Open a command prompt  

3. Type dsadd group “CN=Finance,OU=Groups,DC=FinalVision,DC=Com” –samid Finance Group  -

secgrp yes –scope g  

4. Confirm that group was created by using ADUC  

 

Exercise 2: Import Groups with CSVDE 
  

1. Open Notepad and type the following  

 

 

 

 

 

 

 

2. Save the file to your Documents folder with the name “Importgroups.csv” 

3. Open a command prompt  

4. Type csvde –I –f  “%userprofile%\importgroups.csv” 

5. Confirm the changes in ADUC 

 

Exercise 3: Modify Group Membership with LDIFDE 
  

1. Open Notepad and type the following  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

objectClass, sAMAccountName, DN, member  

group,Accounting,”CN=Accounting, OU=Groups,DC=FinalVision,DC=Com”, “CN=Scott 

Milner,OU=Employees,DC=FinalVision,DC=Com”; “CN=Mary Star,OU=Employees,DC=FinalVision,DC=Com” 

 

 

 

dn: CN=Accounting, OU=Groups, DC=FinalVision, DC=Com 

changeType: modify  

add: member  

member: CN=Toya Jackson,OU=Employees, DC=FinalVision,Dc=Com 

member:CN=Scott Milner,OU=Employees,DC=FinalVision,DC=Com 

- 

dn: CN=Accounting, OU=Groups, DC=FinalVision, DC=Com 

changeType: modify  

add: member  

member: CN=Mary Star,OU=Employees, DC=FinalVision,Dc=Com 
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2. Save the file to your Documents folder as “Membershipchange.ldf” 

3. Open a command prompt  

4. Type ldifde –I –f  “%userprofile%\documents\membershipchange.ldf” 

5. Confirm that membership of Accounting group has been changed  

 

Exercise 4: Modify Group Membership with Dsmod 
  

1. Open a command prompt  

2. Type dsmod group “CN=Finance, OU=Groups, DC=FinalVision, DC=Com” –addmbr  “CN=Scott 

Milner, OU=Employees, DC=FinalVision, DC=Com” “CN=Acccounting, 

OU=Groups,DC=FinalVision, DC=Com” 

3.  Confirm the changes in ADUC  

 

Exercise 5: Confirm Group Membership with Dsget 
  

1. Open a command prompt  

2. Type dsget group “CN=Accounting,OU=Groups,DC=FinalVision,DC=Com” –members  

3. Press ENTER 

4. Type dsget group “CN=Finance, OU=Groups, DC=FinalVision,DC=Com” – members   

5. Press ENTER  

6. Type dsget group “CN=Finance, OU=Groups, DC=FinalVision,DC=Com” –members –expand 

7. Press ENTER 

8. Type dsget user “CN=Scott Milner, OU=Employees, DC=FinalVision, DC=Com” –memberof 

9. Press ENTER 

10. Type dsget user “CN=Scott Milner, OU=Employees, DC=FinalVision, DC=Com” –memberof  -

expand 

11. Press ENTER 
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Module 11– Administering Groups in an Enterprise 

Requirements 

Use the DC1 that was created in Exercise 1 
First Level Employees, Groups 
A global security group in the Groups OU named Sales  
Scott Milner  
Toya Jackson 
Mary Star  
 

Exercise 1: Create a Well-Documented Group 
  

1. Logon to DC1 as an Administrator 

2. Select the Groups OU in the console tree  

3. Right-Click the Groups OU, choose New and then select Group  

4. Group Name Box type ACL_Budget_Edit  

5. Select Domain Local in the Group Scope section and Security in the Group Type section, and click 

OK  

6. Click the View menu and ensure Advanced Features is selected  

7. Right-Click the ACL_Budget_Edit group and choose Properties  

8. Click the Object Tab 

9. Select the Protect Object From Accidental Deletion check box and Click OK  

10. Open the group’s Properties again 

11. Description box type BUDGET (EDIT) 

12. Notes field type the following  

 

 

 

 

 

 

13. Click OK  

 

Exercise 2: Delegate Management of Group Membership 
  

1. Open the Properties dialog box of ACL_Budget_Edit group  

2. Click the Manage by tab 

3. Click the Change button  

4. Type the user name for Scott Milner and click OK  

5. Select the Manager Can Update Membership List check box Click OK  

 

  

\\SRV1\data$\finance\budget 

\\SVR2\data$\finance\revenue projections 

 

 

 

 

 

file://SRV1/data$/finance/budget
file://SVR2/data$/finance/revenue
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Exercise 3: Validate the Delegation of Membership Management  
  

1. Open a command prompt  

2. Type runas /user:Scott cmd.exe  

3. Enter the Password Pa$$w0rd 

4. Type the following dsmod group “CN=ACL_Budget_Edit, OU=Groups, DC=FinalVision, DC=Com” 

–addmbr “CN=Finance, OU=Groups, DC=FinalVision, DC=Com” 

5. Close command prompt  

6. Confirm the changes in ADUC 
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Module 11– Creating Computers and Joining the Domain 

Requirements 

Use the DC1 that was created in Mod 1 Exercise 1 
First Level Admins, Groups 
A global security group in the Admins\Groups OU named Server Admins 
A global security group in the Admins\Groups OU named Help Desk 
Employees OU  
Scott Milner member of Domain Users and Server Admins 
Toya Jackson  
Mary Star member of Domain Users and Help Desk 
 

Exercise 1: Create OUs for Client and Server Computer Objects  
  

1. Logon to DC1 as an Administrator 

2. Open ADUC and expand the domain  

3. Create Desktops and Servers OUs 

 

Exercise 2: Create Computers Objects  
  

1. Right-Click the Desktops OU and select Computer 

2. Computer Name box DESKTOP101 

3. Click the Change button next to the User or Group box  

4. Type Help Desk in the Select User Or Group dialog box that will be allowed to join the computer to 

the domain 

5. Click OK  

6. Create a New Computer in Server OU named Server02 

7. Click Change button next to User or Group box  

8. Type Server Admins  

9. Click OK  

10. Click OK  

 

Exercise 3: Delegate the Ability to Create Computer Objects 
  

1. Logon to DC1 as an Administrator 

2. Open ADUC  

3. Click View menu and ensure Advanced Features is selected  

4. Bring up the properties of Desktops OU  

5. Click the Security tab  

6. Click Advanced  

7. Click Add  

8. Type Help Desk 

9. Click the Object tab  

10. Select This Object and All Descendant Objects from the Drop-Down list  

11. In the Permissions list select Allow next to Create Computer Objects 

12. Click OK three times  

 

Exercise 4: Redirect the Default Computer Container 
  

1. Open a command prompt  

2. Type redircmp “OU=Desktops, DC=FinalVision, DC=Com” 
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Module 12– Create and Manage a Custom MMC 

Requirements 

Use the DC1 that was created in Mod 1 Exercise 1 
First Level Admins, Groups 
A global security group in the Admins\Groups OU named Server Admins 
A global security group in the Admins\Groups OU named Help Desk 
Employees OU  
Scott Milner member of Domain Users and Server Admins 
Toya Jackson  
Mary Star member of Domain Users and Help Desk 
Windows PowerShell must be installed 
 

Exercise 1: Create a Computer with Dsadd 
  

1. Logon to DC1 as an Administrator 

2. Open a command prompt  

3. Type dsadd computer “CN=DESKTOP100, OU=Employees, DC=FinalVision, DC=Com” 

4. Confirm the computer was created  

 

Exercise 2: Import Computers by Using CSVDE 
  

1. Open Notepad 

 

 

 

 

 

 

 

 

2. Save the file to your Documents folder as “Computers.csv”  

3. Open a command prompt  

4. Type csvde –I –f  “%userprofile%\documents\computers.csv” 

5. Confirm changes with ADUC 
  

DN,objectClass,name,userAccountControl,sAMAccountName 

“CN=DESKTOP153,OU=Desktops,DC=FinalVision,DC=Com”, computer, DESKTOP153, 4096, DESKTOP153$ 

“CN=DESKTOP154,OU=Desktops,DC=FinalVision,DC=Com”, computer, DESKTOP154, 4096, DESKTOP154$ 

“CN=SERVER03,OU=Servers,DC=FinalVision,DC=Com”, computer, Server03, 4096, Server03$ 
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Exercise 3: Import Computers by Using LDIF file 
  

1. Open Notepad 

2. Enter the following information 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Save file to Documents folder as “Computers.ldf” 

3. Open a command prompt  

4. Type ldifde –I –f  “%userprofile%\documents\computers.ldf” 

5. Confirm with ADUC that computer account was created 
  

dn: CN=Server10, OU=Servers, DC=FinalVision, DC=Com” 

changeType: add  

objectClass: Top 

objectClass: person 

objectClass: organizationalPerson 

objectClass: user  

objectClass: computer 

cn: Server10 

userAccountControl: 4096 

sAMAccountName: SERVER10$ 

dn: CN=Server11, OU=Servers, DC=FinalVision, DC=Com” 

changeType: add  

objectClass: Top 

objectClass: person 

objectClass: organizationalPerson 

objectClass: user  

objectClass: computer 

cn: Server11 

userAccountControl: 4096 

sAMAccountName: SERVER11$ 
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Exercise 4: Create a Computer with Windows PowerShell 
  

1. Open Windows PowerShell 

2. Type the following 

 

 

 

 

 

 

 

 

 

3. Confirm with ADUC that computer was created  

 

Exercise 5: Create a Computer with VBscript 
  

1. Open Notepad 

2. Type the following 

 

 

 

 

 

 

 

 

 

3. Save the file to your Documents folder as “CreateComputer.vbs” 

4. Type cscript “%userprofile%\documents\createcomputer.vbs” 

5. Confirm with ADUC that computer was created 
  

$objOU = *ADSI+”LDAP:// OU=Desktops,DC=FinalVision,DC=Com” 

$objComputer = $objOU.Create(“computer”,”CN=DESKTOP300”) 

$objComputer.Put(“sAMAccountName”,”DESKTOP300$”) 

$objComputer.Put(“userAccountControl”, 4096) 

$objComputer.SetInfo() 

Set objOU =GetObject(”LDAP:// OU=Desktops,DC=FinalVision,DC=Com”) 

Set objComputer = $objOU.Create(“computer”,”CN=DESKTOP400”) 

objComputer.Put “sAMAccountName”,”DESKTOP400$” 

objComputer.Put “userAccountControl”, 4096 

objComputer.SetInfo() 
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Module 13– Supporting Computer Objects and Acccounts 

Requirements 

Use the DC1 that was created in Mod 1 Exercise 1 
First Level Admins, Groups 
A global security group in the Admins\Groups OU named Server Admins 
A global security group in the Admins\Groups OU named Help Desk 
Employees OU  
Scott Milner member of Domain Users and Server Admins 
Toya Jackson  
Mary Star member of Domain Users and Help Desk 
Windows PowerShell must be installed 
All computers from Module 12  
 

Exercise 1: Manage Computers Objects 
  

1. Logon to DC1 as an Administrator 

2. Open ADUC 

3. Select Desktops OU 

4. Bring up the properties of one of the computers  

5. Click Manage By Tab  

a. Notice this is the same as the group  

6. Change the Description to Sales Desktop for All of the Desktops  

 

Exercise 2: Troubleshoot Computer Acccounts 
  

1. Open a command prompt  

2. Type nltest /? and Press ENTER 

a. Displays the settings for nltest  

3. Type netdom /? and Press ENTER 

4. Simulate a reset by typing netdom reset desktop300 

a. An error will show because the computer is not available 

 

 

 

 

 

 

 

 

 


